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1. Installation 

1.1 Installation Process 

Step 1: Unpacking the Unit 

 

This package contains the following items: 

 

� The unit 

� Quick Start Guide 

� Screws for disk drives (1 package) 

� Power cord 

� Warranty card 

� 12V DC power transformer (2 bay unit) 

� CD with Install Wizard, Backup, Live View, and Playback 

application, user manual, and quick start guide 

 

Warning 

The electronic components within the unit are sensitive to 

damage from Electro-Static Discharge (ESD). Please take 

precautions at all times when handling the unit or its 

sub-assemblies. 

 

Important 

To configure the unit, you must install the software onto a 

desktop/ laptop running Windows Vista, 2003, XP Professional, 

or 2000. 

 

 

2 bay unit (4 channels) front view 

 

 

 

 

 

 

 

 

Disk Drive 
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Drive Status LED 

Drive Activity LED 

Ethernet Activity  
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Power button 

System Status LED 
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2 bay unit (4 channels) rear view 

 

 

 

 

 

 

 

 

 

 

 

 

 

4 bay unit (8 channels) front view 
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4 bay unit (8 channels) rear view 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Disk Drive Installation 

 

You can populate this unit with SATA 1.5 Gb/s or 3.0 Gb/s disk drives. For 

optimal performance, install disk drives of the same model and capacity. 

Your disk drives will become a RAID Volume on this unit. 

 

1. Open the lid on the front of the unit enclosure. 

2. Pull a disk drive carrier from the enclosure. See the front view figure. 

3. Carefully lay the disk drive into the drive carrier, making the screw holes 

on the sides of the carrier align with the screw holes in the drive. 

4. Insert the screws through the holes in the drive carrier and into the sides 

of the disk drive. 

 

� Install only the counter-sink screws supplied with the unit. 

� Install four screws per disk drive. 

� Tighten each screw until snug. Be careful not to over-tighten. 

 

5. Reinstall the drive carrier into the unit enclosure. 

6. Repeat step 2 through 5 for the other disk drive. 

7. Close the lid on the front of the unit. 

 

Cooling Fan 

RJ45 Network 
Connection 

USB Connections 

Power Supply Fan 

Power Connection 
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Step 3: Connecting to the Network 

 

1. Attach one end of the network cable to the RJ45 network connection. 

See the rear view figure. 

2. Attach the other end of the network cable to your Ethernet hub or 

switch. 

Important 

If there are multiple networks at your facility, note the network to 

which you connect the unit. You will need this information during 

the setup process. 

 

 

Step 4: Connecting the Power 

 

1. Attach the power cord from the power source to the power adapter. 

2. Connect the power adapter to the back of the unit enclosure. See the 

rear view figure. 

3. On the front of the unit, press the power button. See the front view 

figure. 

 

It takes about a minute for the unit to fully power up. After power-up: 

� The System Status LED turns green. See the front view figure. 

� The buzzer beeps one time. 

 

Step 5: Software Installation 
 

 

1. Insert the CD into your CDROM. 

2. Double-click Setup.exe to begin installation. 

3. Click the Next button to go on installation. 

4. Click the “I accept the terms of the license agreement” option, and 

then click the Next button. 

5. Insert your “User Name” and “Company Name” then click the Next 

button. 

6. Select the setup type, and then click the Next button. 

7. Click the Install button to proceed with installation. 

8. When above-mentioned installation processes are finished, a final 

installation screen appears. Click the Finish button to close the installer. 
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Step 6: Setting up the Unit 

 

The software Install Wizard performs the setup procedures on your unit. 

After the procedure, you can begin using this unit. 

 

1. Go to Start > NUUO NVRmini > Install Wizard. 

2. This program will show the default language setting and initiation mode. 

3. Choose preferred language and initiation mode, and then click the Next 

button. 

 

 

 

� Express Mode: you don’t need to set the date, time, network settings, 

and RAID level. (After step 5, jump to step 9 directly.) 

� Advance Mode: you need to set your specific date, time, and 

network settings. 

 

4. Install Wizard program will search all the units on the Internet right now. 

Choose one of them, and then click the Next button. 
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5. Enter your password, and then click the OK button. 

 

 

 

Note 

The default Administrator password is “admin”. 

 

 

 

 

6. Set the time zone, date, and time, and then click the Next button. 
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7. Choose the network settings, and then click the Next button. 

 

 

 

� Obtain network settings automatically from DHCP server or 

wizard: apply settings (such as IP, net mask, gateway, DNS) which 

are automatically generated by the DHCP server. 

� Make network settings manually: individually select your specific 

settings. 

 

8. If you need to set a new disk(s), check the “Create new storage” option. 

After checking, click the Next button. 
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� Data Protection: set the RAID level to RAID 1 (2 bay). Set the RAID 

level to RAID 5 (4 bay). 

� Maximum Capacity: set the RAID level to RAID 0 (2 bay). Set the 

RAID level to RAID 0 (4 bay). 

 

9. Review your settings. If the settings are correct, click the Finish button 

to finish the settings selection process. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Caution 

Once you have finished the setting selection process, the unit will 

start working. In order to assure the stability of the unit, do not 

pull any disks out when the system is running. 
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1.2 LED Status Definitions 

� System Status LED 

 Green Red Amber 
Definition Healthy Fail Critical 

 

� Drive Status LED 

 Green Red Amber Dark 
Definition Healthy Fail Rebuilding Without disk 

 

� Drive Activity LED 

 Blink No blink 
Definition Activity No activity 

 

� Ethernet Activity LED 

 Green Blink 
Definition Link Accessing 
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2. Settings 

After setting up the unit, log in to the system by entering its IP address in 

the browser. When connecting, choose your language, enter the user name 

and password, and then begin using this system. 

 

 

 

There are four main functions of this unit: settings, live view, playback, and 

logout. They will be shown on the top of the page. 

 

2.1 Camera Setup 

2.1.1 Adding UPnP Cameras 

 

1. Open Internet Explorer and log in to the unit. 

2. Click IP Camera/ Camera Settings. 

3. Click the Camera Search tab. 

4. Click the Search button to search for UPnP cameras. 
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5. The system will list all the currently available cameras. Click the  

icon to add a camera into your camera list. 

 

 

 

6. After clicking the  icon, the camera setting page will pop up. Click the 

item to which you want to add a camera. 

7. Insert the camera name, user name, and password. 

 

 

 

Note 

Some cameras will limit the login authority to the administrator. In 

this condition, you need to change the user name and password 

to the administrator’s to log in to those cameras. 

 

IP Address Vendor Model Name Mac Address 

Model Name Vendor 
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8. Click the Add button to add it. 

9. After clicking the Add button, the updated camera list will be displayed 

in the Camera Setting tab. 

 

 

 

 

 

 

 

 

 

 

10. Repeat steps 5 through 8 to add other cameras to your list. 

 

2.1.2 Adding non-UPnP Cameras 

 

1. Open Internet Explorer and log in to the unit. 

2. Click IP Camera / Camera Settings. 

3. Click the Camera Settings tab, and the camera list will be displayed on 

the bottom of the page. 

4. Click the item to which you want to add a camera. 

 

 

 

5. Enter the camera’s information at the top of the page. 

 

Model Vendor 
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� Camera name: name this camera. 

� Address: the IP address. 

� Port: the transmission port. 

� User name: login user name. 

� Password: login password. 

� Camera Channel: select the number of analog cameras supported 

by one video server from the list. 

� Protocol: data transmission protocol. 

� Vendor: camera vendor name. 

� Model: camera model name. 

 

Note 

Some cameras will limit the login authority to the administrator 

only. In this condition, you need to change the username and 

password to the administrator’s to log in to those cameras. 

 

 

6. Click the Save button. 

 

� Save: save the information of this camera. 

� Reset: return to the latest saved settings of the selected camera. 

� Clear: set all the settings to default value. (Need to click the Auto 

Detection button to store this change.) 

� Auto Detection: after inserting IP address, port, user name, and 

password, click this button to automatically detect all of this camera’s 

information. (such as Camera Channel, Protocol, Vendor, and Model) 

 

7. Repeat steps 4 through 6 to add other cameras into your list. 
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2.1.3 Modifying Camera Information 

 

1. Open Internet Explorer and log in to the unit. 

2. Click IP Camera / Camera Settings. 

3. Click the Camera Settings tab. 

4. Click the camera which you want to modify. 

5. Modify its information at the top of the page. 

 

 

 

6. Click the Save button. 

7. If you want to replace a camera, click that camera, modify its address, 

port, user name, and password, and then click the Save button. 

 

2.1.4 Modifying Camera Parameters 

 

1. Open Internet Explorer and log in to the unit. 

2. Click IP Camera / Camera Parameters. 

3. Click the Camera Parameter tab. 

4. Click the camera which you want to modify in the camera list. 

5. Modify its information at the top of the page. 

6. Click the Save button. 
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� Camera Name: the name of this camera. 

� Video Format: select the type of format which this camera supports. 

� Frame rate: choose the frame rate of the camera. 

� Resolution: choose the resolution of the camera. 

� Quality: choose the image quality of the camera. 

� Audio: check the Enable Audio option to view and enable audio 

recording. 

 

Note 

If the selected frame rate is higher than the camera’s maximum 

frame rate, the system will automatically adjust the frame rate 

downward to the maximum. 

 

 

2.1.5 Viewing Camera Status 

 

1. Open Internet Explorer and log in to the unit. 

2. Click IP Camera / Camera Status. 

3. Click the Camera Status tab. 

 

 

 

� Conn. Status: the status of the connection. Click the Connect or 

Disconnect button to change the connection status. 

� Rec. Status: the set recording schedule of this camera in this time. 

� Framerate: the frame rate of this camera. 

� Bitrate: the transmission bit rate of this camera. 
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2.2 Recording & Response Setup 

2.2.1 Recording Mode Setup 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Recording & Response / Recording settings. 

3. Click the Recording Mode tab. 

4. If selecting Always Recording, the chosen cameras will begin to 

record immediately. 

 

 
 

� No Recording: turn off the recording. 

� Recording by Schedule: recording by schedule. 

� Always Recording: permanently turn on the chosen cameras. 

� Automatic Recycle: check the Enable option to recycle disk space 

automatically when the disk space is full. 

� Keep Video: set a period during which the recorded video clips will 

be kept intact. 

 

2.2.2 Recording Schedule / Event Setup 

 

Instead of Always Recording, you can begin the recording by setting the 

Recording Schedule. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Recording & Event / Recording settings. 

3. Click the Recording Schedule tab. 

4. Check the Day or Week mode. 
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� Day: schedule the cameras to turn the recorder on and off at the 

same time every day according to your setting. 

� Week: schedule the cameras for each day of the week differently. 

 

5. Click the schedule of the camera which needs to be modified.  

6. Click the column on the bottom of the page. 

 

 

 

� Insert: insert new schedules. 

� Delete: delete the selected schedule. 

� Configure: modify the schedule and recording mode settings. 

 

7. The default setting of the camera’s recording schedule is from 00:00 to 

24:00. If you want to modify the time slot, click the Configure button to 

modify the default settings first. 
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8. Choose the recording mode. 

 

 

 

� Always Record: always record. 

� Record on Event: record when events triggered. The event can be 

triggered by Motion or Digital input. 

 

Note 

When setting the event Motion, please first ensure that the 

motion detection function in your camera has been enabled. 
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9. If you want to add another new schedule, click the Insert button to add 

a new one. 

 

 

 

10. Repeat step 9 to add other new schedules. 

11. Repeat steps 5 through 9 to set other cameras. 

12. Click the Save button. 

 

Note 

When changing the motion detection settings of a camera, make 

sure to disconnect your unit and that camera first. Once you have 

finished, re-connecting them will update the settings in your unit. 

 

 

Note 

When setting an event, Motion or Digital input can be triggered 

from other cameras. This means that if the system detects 

motion or digital input from other cameras, the camera will begin 

   recording. 

 

 

 

Insert 
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Note 

There is another way to set the schedule. If you want to change 

the recording time length, drag the end of the time bar from 24:00 

back to the length you wish, and then drag the beginning of the 

time bar to the point at which you would like it to commence 

recording. (You may also click the Insert button to add new 

schedules.) 

 

 

 

 

 

Drag 

Drag 
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2.2.3 Events and Responding Actions Setup 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Recording & Event / Event & Action Management. 

3. Click the Event & Action tab. 

4. Choose the camera, and then select one of the three events. 

 

 

 

� Connect lost: when a connection between the camera and this unit 

is lost, the system will trigger an action. 

� Motion from Camera: when video motion is detected, the camera 

triggers an action. 

� Input: any external input can trigger an action. 

 

Note 

When setting the event Motion from Camera, make sure to set 

up the camera’s motion detection function first. 

 

 

 

5. Click the Add button to set up the responding actions of this event. 
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� Output: when an event occurs, the system will send out an output 

signal to other connected devices. 

� E-Mail: when an event occurs, the system will send e-mail 

notifications. Make sure to add an e-mail address first. 

� CMS: when an event occurs, the system will send out a signal to 

CMS. CMS will highlight this event. 

 

6. Click the action, and then click the Configure button to modify the 

details of that action if necessary. 

7. Repeat steps 4 and 5 to add more actions. 

8. Repeat steps 3 through 5 to set up more cameras. 

 

Note 

You can also set up a response for the hard disk being full. 

 

 

 

Note 

The screen will display the event information when triggered after 

selecting any one of them (Connection lost, Motion on the edge, 

Digital input). 
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2.2.4 SMTP Server Setup 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Recording & Event / E-Mail. 

3. Click the SMTP Server tab. 

 

 
 

� Server Address: SMTP (Simple Mail Transport Protocol) server IP 

address. 

� Sender: sender information. 

� Subject: subject. 

� Body: E-Mail content. 

� SMTP Authentication: before sending out an E-Mail, enter the user 

name and password for SMTP authentication. 

� User Name: user name. 

� Password: password. 

 

2.2.5 Adding Event Contacts 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Recording & Event / E-Mail. 

3. Click the Contacts tab. 
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� Add Contact: add this new contact into the contact list. 

� Reset: return to the latest saved settings of the contact list. 

� Save: save this time modification of the contact list. 

 

4. Insert the name of a new contact. 

5. Insert the e-mail address of this new contact. 

6. Click the Add Contact button. 

7. Click the Save button to save this modification of the contact list. 

 

2.3 RAID & File Settings 

2.3.1 Viewing RAID Volume Status 

 

RAID status refers to the disk drives on your unit and how they are 

arranged into a RAID Volume. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click RAID & File System / RAID Management. 

3. Click the RAID Status tab to view the status of your RAID Volume. 
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� RAID Name: name of your RAID, automatically assigned when it was 

created. 

� RAID Level: RAID 0, 1, 5, or 10, specified when it was created. 

� Capacity: data capacity of the RAID Volume in GB. 

� RAID Status: functional is normal. Critical means one disk drive 

has failed. Offline means you cannot access your data. 

� Action Status: idle is normal. Rebuilding means the RAID Volume 

is being rebuilt after a disk drive failure. Migrating means the RAID 

Volume is adding a disk drive or changing RAID levels. 

� Background Activity: None is normal. Running means a 

background activity is in progress. 

 

2.3.2 Viewing Disk Drive Information 

 

1. Open Internet Explorer and log in to the unit. 

2. Click RAID & File System / RAID Management. 

3. Click the RAID Status tab. 

4. Click a disk icon to view the disk drive information. 

 

 

 

2.3.3 Migrating a RAID Volume 

 

To migrate a RAID Volume means to change its RAID level or to add disk 

drives. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click RAID & File System / RAID Management. 
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3. Click the Modify tab. 

 

 

 

4. From the Current Volume drop-down menu, choose the RAID Volume 

which needs to be modified. 

5. In the Migrate to RAID Level drop-down menu, choose the target RAID 

Level. 

6. To add disk drives, highlight disk drives in the Free Disks column and 

click the >> button to move them to the Disks in RAID column. 

7. Click the OK button to finish it. 

 

With those steps, the RAID Volume is modified as you directed. Migration 

requires several minutes, depending on the type of modification taking 

place and the size of your disk drives. 

 

During the modification, your RAID Volume and all of the folders on it are 

fully accessible. 

 

After the migration is completed, you must extend the file system so as to 

use the storage space you have added. You can extend the file system 

immediately or wait until later. 

 

8. Click the RAID & File System / File System Management. 

9. Click the Extend File System button. 
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2.3.4 Creating a RAID Volume 

 

In this system, the term RAID Volume refers to one or more disk drives 

working together as a RAID logical drive. You must have unassigned disk 

drives in your unit to create a new RAID. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click RAID & File System / RAID Management. 

3. Click the Create tab. 

 

 

 

4. From the RAID Level drop-down menu, choose the RAID level you 

prefer for your disk array. 

5. Highlight disk drives in the Free Disks column, then click the >> button 

to move them to the Disks in RAID column. 

6. Click the OK button. 

 

The RAID Volume is created and formatting begins. Formatting requires 

several minutes, depending on the size of your disk drives. 

 

Important 

After setting the RAID level and disks, we recommend not 

changing the number of disks. Changing the number of disks 

requires a re-creation of the RAID level, which will destroy all of 

your data. 
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Note 

If you use Express Mode when using the Install Wizard, the 

disk(s) will be set to RAID 1 (2 bay) or RAID 5 (4 bay) 

automatically. If you use Advance Mode when using the Install 

Wizard, the disk(s) will become the RAID level you set. (See 

page 12 for more details) 

 

 

2.3.5 Designating a Spare Drive 

 

If you have an unassigned disk drive, you can assign it as a spare drive. 

 

1. Insert the unassigned disk drive. 

2. Open Internet Explorer and log in to the unit. 

3. Click RAID & File System / RAID Management. 

4. Click the Create tab. 

5. From the RAID Level drop-down menu, choose Spare Disk. 

 

 

 

6. Highlight a disk drive in the Free Disks column and click the >> button to 

move it to the Disks in RAID column. 

7. Click the OK button. 

 

2.3.6 Deleting a RAID Volume 

 

1. Open Internet Explorer and log in to the unit. 

2. Click RAID & File System / RAID Management. 

3. Click the Delete tab. 
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4. Click the option button beside the RAID Volume you want to delete. 

5. Click the OK button. 

6. In the confirmation box, type “YES” into the field provided, and then 

click the OK button. 

7. After a RAID Volume is deleted, you need to reboot the unit. 

 

Caution 

When you delete a RAID Volume, you delete all the folders in the 

RAID volume and all the data saved in the folders. Back up any 

important data before deleting a RAID Volume. 

 

Note 

You cannot delete a RAID Volume while a background activity is 

running, such as Migration or Rebuild. Wait until these activities 

are completed. 

 

 

2.3.7 Viewing Protocol Status 

 

There are another two ways to access the recorded data in the unit: 

through Workgroup or through FTP. Follow the following steps to view the 

status of these two ways. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click RAID & File System / Protocol Control. 

3. Click the Information tab. 
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2.3.8 Modifying the “My Network Places” Protocol Settings 

 

1. Open Internet Explorer and log in to the unit. 

2. Click RAID & File System / Protocol Control. 

3. Click the Windows tab. 

4. Check and enter the unit’s information. 

5. Click the OK button. 

 

 

 

� Services: whether users can access this unit through Windows 

Explorer or not. 

� Computer Name: the name of this unit, which is set in the Setup tab 

in the Network Setup function. 

� Computer Description: the name which will be displayed in 

Windows Explorer. 

� Domain or Workgroup Name: the name of this unit’s workgroup. 

 

2.3.9 Modifying the FTP Protocol Settings 

 

1. Open Internet Explorer and log in to the unit. 

2. Click RAID & File System / Protocol Control. 

3. Click the FTP Sharing tab. 

4. Check and enter the settings of this unit. 
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5. Click the OK button. 

 

 

 

� Services: whether users can access this unit through FTP or not. 

� Command Port: the port for commands between a server and a 

client. 

� Passive Ports: the data transmission port of passive mode. 

� Client Coding Type: If your FTP client uses double-byte characters 

but does not support Unicode, choose your FTP client’s encoding 

from the Client Coding Type drop-down menu. 

 

2.4 Network Setup 

2.4.1 Viewing Network Status 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Network Setup / Network Setup. 

3. Click the Information tab to display the unit’s network information. 
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2.4.2 Network Settings 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Network Setup / Network Setup. 

3. Click the Setup tab to set up the network settings of your unit. 

 

 

 

� Computer Name: name your unit. 

 

Note 

Because of the internal data modifications required, it will take a 

few minutes to change the name of your unit. During this period, 

it will not be possible for you to access your unit. There is no  

   need to restart the unit; simply wait until it is possible to re-  

   access. 

 

 

� Ethernet Link Speed: select the LAN transmission speed you prefer. 

(4 bay) 

� Internet Protocol: check whether you want to apply a specific 

internet protocol to your unit. 

� IP Address: IP address of this unit. 

� Subnet Mask: subnet mask address. 

� Default Gateway IP Address: gateway IP address. 

� Primary DNS: primary DNS (Domain Name System) address. 

� Secondary DNS: secondary DNS address. 
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4. Click the Jumbo Frame tab to use the unit’s maximum transmission 

settings. 

 

 

 

� Ethernet Link Mode: full duplex or half duplex transmission. 

� Ethernet Link Speed: transmission speed. 

� Maximum Transmission Unit: limit the maximum transmission size. 

If the transmission package is larger than this setting, the system will 

divide it into smaller packages when transmitting. 

 

5. Click the Port Setup tab to set the port of your unit. 

 

 

 

2.4.3 Network Service Setup 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Network Setup / Network Service. 

3. Click the Live View & Playback Service tab. 
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� Live Streaming Server 

� Port: live streaming transmission port. 

� Maximum Connections: maximum connections from remote 

access. 

� Playback Server 

� Port: playback transmission port. 

� Maximum Users: the number of users who can access playback 

functions at the same time. 

� Allowed/ Blocked List 

� Allowed List: only IP addresses from the allowed list are allowed 

to log in. 

� Blocked List: IP addresses from the blocked list will be unable to 

log in. 

 

Note 

When setting Maximum Connections in Live Streaming Server 

settings, 1 connection means that only 1 user can connect to only 

1 camera. If the maximum connections value is set to 16, and 

each user connects to 4 cameras, the allowed connections per 

user will become 4, rather than 16. 
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2.4.4 CMS Service Setup 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Network Setup / Network Service. 

3. Click the CMS Service tab. 

 

 

 

� CMS Server: check the Enable option to enable CMS service. 

� Port: the port number through which the CMS connects to this unit. 

� Maximum Connections: the maximum number of allowed CMS 

connections. 

 

2.5 Management 

2.5.1 Viewing the List of Users 

 

1. Open Internet Explorer and login the unit. 

2. Click Management/ User Management. 

3. Click the Create New Users tab. 

4. The list will be displayed on the bottom of the page. 

 

 

 

2.5.2 Creating New Users 

 

1. Open Internet Explorer and login the unit. 

2. Click Management/ User Management. 

3. Click the Create New Users tab. 
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4. Insert the user name of this new user. 

5. Insert the password of this new user. 

6. Choose the group of this user. 

 

� Power user: power user can do all the settings except the Network 

Settings, RAID Settings, and Management function. 

� User: user just can change his/her password and do the live view and 

playback functions. 

 

7. Select the live view cameras which this user can access. 

8. Select the playback channels which this user can access. 

9. Check whether this user can backup or delete recorded data. 

10. Click the Create New User button to finish it. 

 

Note 

The Administrator will be the only user who can use all of the 

functions. There is a default administrator account in the system, 

and you cannot create another “Administrator” account. 

 

 

2.5.3 Modifying User Information 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Management / User Management. 

3. Click the Modify Users tab. 

4. Click one of the users in the User List on the bottom of this page. 
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5. Change the group of this user. 

6. Select the live view cameras which this user can access. 

7. Select the playback channels which this user can access. 

8. Check whether this user can backup or delete recorded data. 

9. Click the Modify User button to finish it. 

 

2.5.4 Changing a User’s Password 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Management / User Management. 

3. Click the Change Password tab. 

 

 

 

4. Choose the user. 

5. Enter a new password. 

6. Enter this new password again. 
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7. Click the OK button. 

 

2.5.5 Deleting Users 

 

Except for the administrator, you can delete any users with the following 

steps. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Management / User Management. 

3. Click the Modify Users tab. 

4. Click the Delete icon of the user you want to delete. 

 

 

 

5. In the confirmation box, click the OK button. 

 

2.5.6 Viewing the Event Log 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Management / Event Log to find the event list of your unit. 

 

 
 

There are three kinds of event which will be listed on this page. 

 

� Hardware Log: the log information of the operations to your unit, 

such as reboot or shutdown. 

� NVR Log: the log information of the NVR system, such as stop 
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recording or NVR system start. 

� NVR Event Log: the log information of the “Event & Action 

Management”, such as motion detection or camera connection lost. 

 

2.5.7 Saving Unit Configuration 

 

Save configuration can let you save the settings of this unit. These settings 

can be applied to other units, which will let you set other units more easily. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click Management / Save / Load Configuration. 

3. Click the Save Configuration tab. 

 

 

 

4. Choose the volume. 

5. Choose the folder which the configuration file will be generated into. 

6. Insert the file name. 

7. Click the OK button. 

8. The configuration file will be generated into the chosen folder. 

 

2.5.8 Loading Unit Configuration / Default Settings 

 

Load configuration can let you apply another unit’s settings to the current 

unit. Load Default Settings will revert all of the unit’s settings back to the 

default factory settings. 

 

1. Find your unit through Windows Explorer (insert “\\” plus the IP address 

of your unit). 

2. Use the administrator’s ID to log in. 

3. Put the configuration file into the folder “public” in your unit. 
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4. Open Internet Explorer and log in to the unit. 

5. Click Management / Save / Load Configuration. 

6. Click the Load Configuration tab. 

 

 

 

7. Check the Load Configuration or the Load Default Settings option. If 

choosing Load Default Settings, jump to step 11 directly. 

8. Choose the volume. 

9. Choose the folder “public”. 

10. Insert the file name. 

11. Click the OK button. 

12. In the confirmation box, type “YES” into the field provided, then click the 

OK button. 

13. The system will begin to load the settings into your current unit. 

 

2.6 System 

2.6.1 Viewing System Information 

 

1. Open Internet Explorer and log in to the unit. 

2. Click System / System Information. 

3. Click the System Information tab. 
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The system information includes the following items. 

 

� Operating System: embedded Linux 

� OS Version: OS version 

� NVR version: NVR system version 

� CPU: CPU model number 

� Network Adapter: network type and speed 

� MAC Address: MAC address of this unit 

� Network Flow: input/ output network flow 

� Locate: the buzzer in the unit will sound to let you know where the 

unit is. 

 

2.6.2 Viewing Enclosure Information 

 

1. Open Internet Explorer and log in to the unit. 

2. Click System / System Information. 

3. Click the Enclosure Information tab. 
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The enclosure information includes the following items. 

 

� CPU temperature: normal range <= 58℃ 

� System Fan Speed: normal range >= 1800 RPM 

� Power Status 5V: 4.75 V <= normal range <= 5.23 V 

� Power Status 12V: 11.00 V <= normal range <= 12.94 V 

 Power Status 3.3V: 3.12 V <= normal range <= 3.46 V 

 

Note 

If any value is out of specification, see “Check Enclosure Status” 

on page 91. 

 

 

 

2.6.3 Upgrading the System 

 

1. Find your unit through Windows Explorer (insert “\\” plus the IP address 

of your unit). 

2. Use the administrator’s ID and password to log in. 

3. Put the upgrade file into the folder “public” in your unit. 

4. Open Internet Explorer and log in to the unit. 

5. Click System / System Upgrade. 

6. Click the Firmware Upgrade tab. 
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7. Choose the volume. 

8. Choose the folder “public”. 

9. Insert the entire file name, including the extension name. 

10. Click the OK button. 

11. The system will begin the upgrade process. 

12. After upgrade, the system will restart. You need to re-access the unit 

again after this. 

 

2.6.4 System Date and Time Setup 

 

1. Open Internet Explorer and log in to the unit. 

2. Click System / Date / Time. 

3. Click the Setup tab. 

 

 

 

4. Choose the year. 

5. Choose the month. 

6. Choose the day. 

7. Choose the time. 

8. Click the OK button. 
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Caution 

When you modify the date or time of the system, the system may 

find the wrong data when searching the recorded data. Back up 

the recorded data before changing the time. 

 

Note 

After you modify the date or time of the system, you need to 

restart it. 

 

 

 

2.6.5 Daylight Saving Time Setup 

 

1. Open Internet Explorer and log in to the unit. 

2. Click System / Date / Time. 

3. Click the Time Zone tab. 

 

 

 

4. Check the Adjust clock for daylight saving changes option. 

5. Choose the increment for daylight saving time in your location. 

6. Click the OK button. 

 

2.6.6 Enabling and Disabling the Buzzer 

 

There is a buzzer in the unit. When the unit finishes booting or when a 

problem is detected, this buzzer will sound. This buzzer is enabled by 

default. You can disable/enable this buzzer with the following steps. (We 

recommend that this buzzer should be enabled.) 

 

1. Open Internet Explorer and log in to the unit. 

2. Click System / Buzzer. 

3. Click the Setup tab. 
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4. Check the Enable or Disable option. 

5. Click the OK button. 

 

2.6.7 Viewing UPS Status 

 

If you have an APC Uninterruptable Power Supply (UPS) attached to your 

unit, you can check its status with the following steps. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click System / APC UPS. 

3. Click the Information tab. 

 

 

 

The Information tab displays the status of the UPS. If there is no UPS 

connected or recognized, the Service Status field reports “NO UPS.” 

 

 
 

2.6.8 UPS Setup 

 

This feature enables you to tell your unit how long to run on UPS battery 

power and when to shutdown, after a power failure. 
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1. Attach the APC UPS to one of the unit’s USB ports. 

2. Open Internet Explorer and log in to the unit. 

3. Click System / APC UPS. 

4. Click the Setup tab. 

5. Click the option button beside the shutdown option you want: 

 

 

 

� Disable: run until the UPS battery is depleted 

� System shutdown on the remaining battery percentage: run until 

the UPS battery remains this percentage. 

� System shutdown after the UPS has run on batteries: run on the 

UPS battery for a certain period of time. 

 

6. If you choose battery percentage, enter a percentage amount in the % 

field. 

7. If you choose running time, enter the number of minutes into the Mins. 

field. 

8. Click the OK button. 

 

2.6.9 Restarting the Unit 

 

1. Open Internet Explorer and log in to the unit. 

2. Click System / Reboot / Shutdown. 

3. Click the Options tab. 
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4. Check the Reboot option. 

5. Click the OK button. 

6. In the confirmation box, click the OK button. 

 

The restart procedure runs automatically. When the unit is fully online: 

� The system status LED turns green (right) 

� The buzzer beeps one time (if the buzzer is enabled) 

 

Note 

During system restart, none of your files will be accessible from 

your desktops / laptops. 

 

 

2.6.10 Shutting Down the Unit 

 

The only time you need to shut down the unit is to replace the disk drive 

cooling fan or the power supply. During and after the shutdown, none of 

your files will be accessible from your desktops / laptops. 

 

� Shutdown by Software 

1. Open Internet Explorer and log in to the unit. 

2. Click System / Reboot / Shutdown. 

3. Click the Options tab. 

4. Check the Shutdown option. 

5. Click the OK button. 

6. In the confirmation box, click the OK button. 

 

� Direct Shutdown 

1. Press and hold the power button for 5 seconds on your unit’s front 

panel. 

2. The system status LED will turn red. 
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Log In/ Log Out 
(Live view service) 
 

 

Camera List  
 
 
 
PTZ Camera  
Control  

3. Live view 

 

There are two ways to implement the live view function: with Internet 

Explorer or with the Remote Live Viewer application. 

 

3.1 Internet Explorer 

3.1.1 Live View Control Panel 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remote I/O 

 

Snapshot 

 

Digital Zoom 

 

Play/ Stop / Drop 

 

Information 
Display Window 

 

Zoom 
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� PTZ Camera Control: you may control the camera view by using the 

PTZ camera control panel to adjust the camera’s view. This is only 

available with cameras that support the PTZ function. 

� Zoom: click the + or – button to zoom in or zoom out the view. 

� Digital Zoom: click the  or  icon to digitally zoom in or out. 

� Play / Stop / Drop: select a camera / video and click this button to 

play/stop/disconnect a particular channel. 

� Information Display Window: display video information including 

server name, video current status, and bit rate for a selected channel. 

� Snapshot: select the snapshot function to capture a specific video 

image immediately. 

� Remote I/O: utilize I/O device function remotely. - User can remotely 

adjust the Output Pins by turning it on or off. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.1.2 Live View Setup 

 

1. Open Internet Explorer and log in to the unit. 

2. Set the cameras. 

3. Click the Live view button on the top of the page. 

4. Select a camera(s) from the camera list on the right and then drag it to 

where you wish the image to be displayed. 

 

Click to turn on/off the 
“Output” pins 
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Important 

When running Internet Explorer, do not use the function “Open in 

New Window”. Using this function may cause Internet Explorer to 

become unstable. 

 

 

3.2 Remote Live Viewer Application 

3.2.1 Remote Live Viewer Application Control Panel 

 

� PTZ Camera Control: you may control the camera view by using the 

PTZ camera control panel to adjust the camera’s view. This is only 

available with cameras that support the PTZ function. 

� Zoom: click the + or – button to zoom in or zoom out. 
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Log In/ Log Out 

(Server/ Group) 

 

 

Server and Camera 

List  

 

 

 

PTZ Camera 

Control  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Minimize 

 

Exit 

 

Digital Zoom 

 

Play/ Stop / Drop 

 

Information 

Display Window 

 

Playback 

 
Remote I/O 

 

Snapshot 

 

Zoom 
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� Minimize: minimize the Remote Live Viewer window. 

� Exit: shut down the application. 

� Digital Zoom: click the  or  icon to digitally zoom in or out. 

� Play / Stop / Drop: select a camera/ video and click this button to 

play/stop/disconnect a particular channel. 

� Information Display Window: display video information including 

server name, video current status, and bit rate for a selected channel. 

� Playback: view playback video remotely. 

� Snapshot: Select the snapshot function to capture a specific video 

image immediately. 

� Remote I/O: utilize I/O device function remotely. - User can remotely 

adjust the Output Pins by turning it on or off. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.2.2 Unit Connection Setup 

 

1. Go to Start > NUUO NVRmini > Remote Live Viewer. 

2. Click the LiveView Setting button. 

 

Click to turn on/off the 
“Output” pins 
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3. Insert the unit name. 

 

 
 

4. Insert the IP address. 

5. Modify the port if necessary. 

6. Insert the user name. 

7. Insert the password. 

8. Check the Save Password / Auto login option. 

9. Click the Test Server button to test the connection between the local 

application and the remote unit. 
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10. Click the Add button to add this unit into your remote server list. 

11. Click the OK button. 

 

3.2.3 Camera Group Setup 

 

You can put different cameras into the same group.  

 

1. Go to Start > NUUO NVRmini > Remote Live Viewer. 

2. Click the LiveView Setting button. 

 

 

 

3. Click the Group tab. 
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4. Log in to all the servers that contain the camera(s) you would like to put 

into the group(s). 

5. Click the Insert button to create a new group. 

6. Name this group. 

7. Highlight the camera(s) that you would like to add into this group and 

then click the <-- button. 

8. Repeat step 6 to establish the group.  

9. Repeat steps 3 through 7 to establish other groups. 

10. Click the OK button. 

 

3.2.4 Deleting/ Renaming Camera Groups 

 

1. Go to Start > NUUO NVRmini > Remote Live Viewer. 

2. Click the LiveView Setting button. 

3. Click the Group tab. 

4. Click the group which you want to modify. 

5. Click the Delete or Rename button to remove or rename that group. 

6. Repeat steps 3 and 4 to modify other groups. 

7. Click the OK button. 

 

3.2.5 Setting OSD (On-screen display) 

 

1. Go to Start > NUUO NVRmini > Remote Live Viewer. 

2. Click the LiveView Setting button. 

3. Click the OSD tab. 
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4. Check the Enable camera OSD option. 

5. Set the foreground settings of the OSD. 

6. Set the background settings of the OSD. 

7. Select which kinds of information will be displayed on the screen. 

8. Click the Apply button to preview the result. 

9. Click the Default button to back to the default settings if necessary. 

10. Click the OK button. 

 

3.2.6 Setting Up Remote Live Viewer 

 

1. Go to Start > NUUO NVRmini > Remote Live Viewer. 

2. Click the unit you wish to access in your remote server list. 

3. Click the Log In button to access your unit. 

4. Select a camera(s) from the camera list on the right and then drag it to 

where you wish the image to be displayed. 
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 62 

4. Playback 

 

There are two ways to implement the playback function: with Internet 

Explorer or with the Playback System application. 

 

4.1 Internet Explorer 

4.1.1 Playback Control Panel 

 

 

 

 

 

 

 

 

 

� Information Window: displays video date and time, cue-in / cue-out 

point times, and speed. 

� Audio Volume Control: adjust the sound level. 

� Screen Division: allocate the sub-screen display by clicking on the 

desired layout icon. To switch to single camera display, double click a 

particular sub-screen. Double click the screen again to regain 

previous screen division layout. 

� Browse Mode: play the recorded video when in Search Mode. 

FWD/REV:  

Forward/ reverse by interval. 

Step FWD/REV:  

Forward/ reverse frame by frame. 

 

Browse Mode 

Search Mode 

Open Record 

Audio Volume 
Control 

Information Window 

Screen Division 

Setting 
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� Open Record: click the Open Record button to access the 

Date-Time Panel and select the video records which you want to 

review. 

� Setting 

� Record Display 

� Calendar View: view the Record Display Window as a 

calendar. 

� List Control: view the Record Display Window as a list 

control. 

� Play 

� Play when open: check this option to set the system to start 

playing the video clip every time a record is withdrawn. 

� Auto-skip when recording in motion-only mode: check this 

option to set up the system to automatically skip to the points 

where there were motions recorded. 

� Next interval: set the interval with which the video goes 

forward when you click the Forward button on the control 

panel. 

� Previous interval: set the interval with which the video goes 

backward when you click the Reverse button on the control 

panel. 

� Capture Image 

� Save in clipboard: the image will be saved in the clipboard 

and can be pasted to other application software. 

� Manually save the image file: you can manually select where 

you want to save the image, name the saved file, and choose 

the format you want to save the image. 

� Automatically save the image file: by presetting a path/URL 

and the image format, the system will automatically save the 

image accordingly when you click the Save Image button on 

the control panel. 
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4.1.2 Searching the Recorded Video 

 

 

 
 

� : refresh the Record Display Window. 

�  or : go to previous or next recording date. 

� Record Display Window: display the available recorded video 

records. 

� Date Time Period: select the start and end time points that indicate 

the time period you would like to view after choosing cameras. 

� Video Preview: check the Enable Preview option to view the 

selected video. 

� Time Table (preset recording schedule): click the  icon to select 

all channels; click the  icon to deselect all channels. Finally, use 

the  scale bar to modify the scale of the time table.  

There are two recording modes: Record Always and Record on 

Event. The Time Table will display these two modes in different 

colors. 

� Show Records: show the period of recording data in the Time Table. 

 

1. From the Record Display Window at the top left of 

the Date Time Panel, select the date you want to 

search the record from. The red lines shown on the 

Recording Types 

Time Table 

Date Time 
Period 

Video 
Preview Refresh 

Previous/ Next 
Recording Date 

Record Display 
Window 
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time table indicate available recorded video records. 

2. Use color bars to differentiate recording types from each other. This will 

help you select video clips. 

3. Highlight the video clip you want to review by left-clicking and dragging 

the time period. You may also utilize the Start Time and End Time in 

Date Time Period Section after choosing camera. In addition, modify the 

scale of the time table with the  or  icon on the bottom left. 

4. Check the Enable Preview option to get the preview of the video you 

select. 

5. Click the camera name to increase or decrease cameras you want to 

playback. 

6. Click the OK button. 

 

Note 

The Record Display Window can be shown in (a) calendar view 

or (b) list control view. To modify the settings of the record display 

window, click the Setting button at the right of the page. See 

page 63 for more details. 

 

 

4.1.3 Playing the Recorded Video 

 

1. Be sure that you have set the schedule / recording event first. 

2. Open Internet Explorer and log in to the unit. 

3. Click the Playback button on the top of the page. 

4. Click the Open Record button. 

5. The Record Display Window will show the information of the available 

video clips. Select the date you want to search the record from. See 

page 64 for more details about the Record Display Window. 

6. Highlight the video records that you want to review. See page 65 for 

more details. 

7. Click the OK button. 

 

4.1.4 Smart Search 

 

After opening the recorded video, click the Search Mode button to obtain 

the Intelligent Search Tool panel. You can search for unusual events during 

the recording period. 
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There are 5 types of unusual events: General Motion, Foreign Object, 

Missing Object, Focus Lost, and Camera Occlusion. 

 

� General Motion: detect all movements in the 

defined area. 

 

1. Define detection zone by dragging to draw a 

detection zone. You may define more than one 

zone by repeating this step. 

2. Modify the sensitivity setting by changing the 

slider control. Moving toward the right will 

increase the sensitivity level, which means a 

relatively small movement will trigger the alarm. 

3. Set the interval. Moving toward right will increase 

time interval so that the alarm will only be 

triggered when the movement lasts longer. 

4. Check the Stop when found option. If unchecked, the search tool will 

list all the events it found, instead of stopping at the moment the event 

found. 

5. Click the Search button. 

 

� Foreign Object: alarm is set on when any additional object appears 

in the defined area on the screen. 

 

1. Define detection zone by dragging to draw a detection zone. 

2. Modify the sensitivity setting. 

3. Set the Interval. 

4. Check the Stop when found option. If unchecked, the search tool will 

list all the events it found, instead of stopping at the moment the event 

found. 

5. Click the Search button. 

 

� Missing Object: alarm is set on when the selected object is removed 

from the defined area on the screen. 

 

1. Define detection object by dragging to draw a detection zone. 

2. Modify the sensitivity setting. 
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3. Set the Interval. 

4. Check the Stop when found option. If unchecked, the search tool will 

list all the events it found, instead of stopping at the moment the event 

found. 

5. Click the Search button. 

 

� Focus Lost: system will inform you when the camera(s) lose its 

focus. 

 

� Camera Occlusion: alarms when the camera is blocked. 

 

4.1.5 Recorded Video Enhancement 

 

1. Open Internet Explorer and log in to the unit. 

2. Click the Playback button on the top of the page. 

3. Click the Open Record button. 

4. The Record Display Window will show the information of the available 

video clips. Select the date you want to search the record from. 

5. Highlight the video clip you want to review, and then click the OK 

button. 

6. Click the Enhancement button. 

7. Check the General Setting. 

 

� Apply active channel: the settings will only be 

applied to the selected channel. 

� Apply all channels: the settings will be applied to 

those currently shown on the screen. 

 

8. Set the Filter Setting. 

 

� Visibility: check the option and adjust the gamma 

value of the image to enhance the image and 

make it cleaner. 

� Sharpen: check the option to activate the function. Move the slider 

control to the right to sharpen the image, to the left to soften it. 

� Brightness: check the option to activate the function. Move the slider 

control to the right to make the image brighter. 

� Contrast: check the option to activate the function. Move the slider 
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control to the right to increase contrast. 

� Grey Scale: check the option to show the record in gray-scale mode 

so the image displays in black and white. 

 

9. Click the OK button. 

 

� Stop: stop the enhancement function and close the enhancement 

tool. (The system will automatically back to the default settings.) 

� Default: back to the default settings, however, the enhancement tool 

still works. 

� OK: apply the modifications of the settings. 

 

4.1.6 Saving a Video 

 

1. Open Internet Explorer and log in to the unit. 

2. Click the Playback button on the top of the page. 

3. Click the Open Record button. 

4. The Record Display Window will show the information of the available 

video clips. Select the date you want to search the record from. 

5. Highlight the video clip you want to review, and then click the OK 

button. 

6. Choose the camera display that you want to save as a video clip. 

7. Set up the cue in and cue out points; the cue in and cue out time will be 

shown on the information window. 

 

 

 

 

8. Click the Save Video button. 

Cue In Cue Out 
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9. Choose the folder where you want to save the file. 

10. Insert the file name and click the Save button. 

11. Choose the export format. 

12. Choose the use profile. 

13. Check the Export Audio option. 

14. Click the OK button. 

 

Note 

We recommend that you export to the .asf format when saving 

video. In exporting to the .avi format, the frame rate will be 

increased when playing in the video player, causing the video to 

   run faster than normal. 

 

 

4.1.7 Saving an Image 

 

1. Open Internet Explorer and log in to the unit. 

2. Click the Playback button on the top of the page. 

3. Click the Open Record button. 

4. The Record Display Window will show the information of the available 

video clips. Select the date you want to search the record from. 

5. Highlight the video clip you want to review, and then click the OK 

button. 

6. Choose the camera display that you want to save pictures. 

7. Click the Save Image button when the image you want is shown on 

the screen. 

8. Choose the folder where you want to save the file at. 

9. Choose the folder and the image format (BMP or JPEG) you prefer. 
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10. Insert the file name. 

11. Click the Save button. 

 

Note 

You may skip step 3 by presetting the folder where you want to 

save the images and the format you want to save them in. See 

page 63 for more details. 

 

 

4.1.8 Printing an Image 

 

Print the current image of the video you choose. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click the Playback button on the top of the page. 

3. Click the Open Record button. 

4. The Record Display Window will show the information of the available 

video clips. Select the date you want to search the record from. 

5. Highlight the video clip you want to review, and then click the OK 

button. 

6. Choose the camera display from which you want to print pictures. 

7. Click the Print button when the image you want is shown on the 

screen. 

8. Set print settings. 
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� Page Setting 

� Print in original size: check to have the image print in original 

size. 

� Fit the page: check to have the image fit the page. 

� Align Image: top, center, or bottom 

� Print Content: print the image from currently selected channel or all 

the channels shown on the screen. 

 

9. Click the Print button. 

 

4.1.9 Backing up the Recorded Video 

 

Different from Save Video, the Backup function will save all the recorded 

videos which belong to the time slot you set, instead of the clips. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click the Open Record button to select data. 

3. Click the Backup button. 

 

 

 

4. Set the Start Time and End Time you want to backup. 

5. Select the cameras you want to backup. 

6. Select the directory you want to save the backup data. 

7. Click the Backup button. 
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8. The system will then begin backup process automatically. 

 

 

4.2 Remote Playback System Application 

4.2.1 Playback System Application Control Panel 

 

The Playback System control panel is similar to the playback panel in 

Internet Explorer. See page 62 for more details about those buttons. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
FWD/REV:  

Customize the speed on 
setting panel. 

Browse Mode 

Search Mode 

Open Record 

Audio Volume 
Control 

Information Window 

Screen Division 

Setting 

Step FWD/REV:  

Forward/reverse frame by 
frame. 
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4.2.2 Setting Unit Connections 

 

Before using the Playback System application, you need to set a 

connection to your unit first. 

 

1. Go to Start > NUUO NVRmini > Playback System. 

2. Click the Remote Server button. 

 

 

 

3. Insert the name of your unit. 

4. Insert the IP address of that unit. 

5. Modify the port if necessary. 

6. Insert the user name. 

7. Insert the password. 

8. Check the Save Password option. 

9. Click the Test Server button to test the connection between the local 

application and the remote unit. 

10. Click the Add button to add this unit into the remote server list. 

11. Click the OK button. 
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4.2.3 Searching the Recorded Video to Playback 

 

 
 

1. Go to Start > NUUO NVRmini > Playback System. 

2. Click the Open Record button. 

3. Click the  icon on the top of the Date-Time Panel to obtain the 

Remote Playback Site Management dialog, and then select the server 

you want to access. 

4. Highlight the records you want to view in the Time Table. 

5. Set the Date Time Period. 

 

The search process in the Playback System application is similar to that of 

Internet Explorer. See page 64 for more details about the setting process. 

 

4.2.4 Playing the Recorded Video 

 

1. Be sure that you have set up the recording schedule / response first. 

2. Go to Start > NUUO NVRmini > Playback System. 

3. Click the Remote Server button to set connections to your unit. See 

page 73 for more details. 

4. Click the Open Record button. 

5. The Record Display Window will show the information of the available 

video clips. Select the date you want to search the record from. See 

Remote Playback 
Site Management 
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page 64 for more details. 

6. Highlight the video records that you want to review. See page 65 for 

more details. 

7. Select the start and end points in Date Time Period to adjust the time 

slot. 

8. Click the OK button. 

 

4.2.5 Smart Search from the Recorded Video 

 

1. Go to Start > NUUO NVRmini > Playback System. 

2. Click the Open Record button. 

3. The Record Display Window will show the information of the available 

video clips. Select the date you want to search the record from. See 

page 64 for more details. 

4. Highlight the video records that you want to review. See page 65 for 

more details. 

5. Choose the camera display for which you want to implement smart 

search. 

6. Click the Search Mode button to open the Intelligent Search Tool 

panel. 

7. Set up unusual events here to detect abnormalities occurring during 

the recoding period. See page 66 for more details. 

8. The searched events will be listed. Click to find that event. 

 

There are 5 types of unusual events: General Motion, Foreign Object, 

Missing Object, Focus Lost, and Camera Occlusion. 

 

� General Motion: detect all movements in the defined area. 

� Foreign Object: alarm when any additional object appears in the 

defined area on the screen. 

� Missing Object: alarm when the selected object is removed from the 

defined area on the screen. 

� Focus Lost: system will inform you when the camera(s) lose focus. 

� Camera Occlusion: alarm when the camera is blocked. 

 

The smart search in the Playback System application is similar to that of 

Internet Explorer. See page 66 for more details. 
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4.2.6 Recorded Video Enhancement 

 

1. Go to Start > NUUO NVRmini > Playback System. 

2. Click the Open Record button. 

3. The Record Display Window will show the information of the available 

video clips. Select the date you want to search the record from. See 

page 64 for more details. 

4. Highlight the video records that you want to review. See page 65 for 

more details. 

5. Choose the camera display that you want to implement video 

enhancement. 

6. Click the Enhancement button. 

7. Check the General Setting. 

 

� Apply active channel: the settings will only be applied to the 

selected channel. 

� Apply all channels: the settings will be applied to those currently 

shown on the screen. 

 

8. Set the Filter Setting. 

 

� Visibility: check the option and adjust the gamma value of the image 

to enhance the image and make it cleaner. 

� Sharpen: check the option to activate the function. Move the slider 

control to the right to sharpen the image, to the left to soften it. 

� Brightness: check the option to activate the function. Move the slider 

control to the right to make the image brighter. 

� Contrast: check the option to activate the function. Move the slider 

control to the right to increase contrast. 

� Grey Scale: check the option to show the record in gray-scale mode 

so the image displays in black and white. 

 

9. Click the OK button. 

 

� Stop: stop the enhancement function and close the enhancement 

tool. (The system will automatically revert back to the default 

settings.) 

� Default: back to the default settings, however, the enhancement tool 
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still works. 

� OK: apply the modifications of the settings. 

 

4.2.7 Saving a Video 

 

1. Go to Start > NUUO NVRmini > Playback System. 

2. Click the Open Record button. 

3. The Record Display Window will show the information of the available 

video clips. Select the date from which you want to search the record. 

See page 64 for more details. 

4. Highlight the video records that you want to review. See page 65 for 

more details. 

5. Choose the camera display that you want to save as a video clip. 

6. Set up the cue in and cue out points; the cue in and cue out time will 

show on the information window. 

 

 

 

 

 

 

 

7. Click the Save Video button. 

8. Choose the folder where you want to save the file. 

9. Insert the file name and click the Save button. 

10. Choose the export format. 

11. Choose the use profile. 

12. Check the Export Audio option. 

13. Click the OK button. 

 

4.2.8 Saving an Image 

 

1. Go to Start > NUUO NVRmini > Playback System. 

2. Click the Open Record button. 

3. The Record Display Window will show the information of the available 

video clips. Select the date you want to search the record from. See 

page 64 for more details. 

4. Highlight the video records that you want to review. See page 65 for 

Cue In Cue Out 
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more details. 

5. Choose the camera display from which you want to save pictures. 

6. Click the Save Image button when the image you want is shown on 

the screen. 

7. Choose the folder where you want to save the file at. 

8. Choose the format of image (BMP or JPEG) you prefer. 

9. Insert the file name. 

10. Click the Save button. 

 

Note 

You may skip step 7 by presetting a folder where you want to 

save the images and a format which you want to save the images 

in. See page 63 for more details. 

 

 

 

4.2.9 Printing an Image 

 

Print the current image of the video you choose. 

 

1. Go to Start > NUUO NVRmini > Playback System. 

2. Click the Open Record button. 

3. The Record Display Window will show the information of the available 

video clips. Select the date you want to search the record from. See 

page 64 for more details. 

4. Highlight the video records that you want to review. See page 65 for 

more details. 

5. Choose the camera display that you want to print pictures. 

6. Click the Print button. 

7. Set the print settings. 

 

� Page Setting 

� Print in original size: select to have the image print in original 

size. 

� Fit the page: select to have the image fit the page. 

� Align Image: top, center, or bottom 

� Print Content: print the image from currently selected channel or all 

the channels shown on the screen. 
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4.2.10 Backing up the Recorded Video 

 

Different from Save Video, the Backup function will save all the recorded 

videos which belong to the time slot you set, instead of the clips. 

 

1. Go to Start > NUUO NVRmini > Playback System. 

2. Click the Open Record button to select data. 

3. Click the Backup button. 

4. Set the Start Time and End Time you want to backup. 

5. Select the cameras you want to backup. 

6. Select the directory you want to save the backup data. 

7. Click the Backup button. 
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5. Backing up and Deleting Records 

 

5.1 The Backup System Application 

 

In addition to the ways mentioned in the previous chapters, you can apply 

the application to backup your files. 

 

1. Go to Start > NUUO NVRmini > Backup System. 

2. Insert the IP address of your unit. 

 

 

 

3. Insert the user name. 

4. Insert the password. 

5. Click the OK button. 

6. Click the New Period button. 
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7. Select the record date. 

 

 

 

8. Set the Start Time and End Time you want to backup. (or highlight the 

video records which you want to backup) 

9. Select the cameras you want to backup. 

10. Click the OK button. 

11. Select the time slot which you want to backup. 
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12. Click the Backup button. 

13. Select the way and directory you want to save the backup data. 

14. Check the Include Playback application option, which will add 

Playback application into the backup folder. 

 

 

 

15. Click the OK button. 

 

5.2 Backing up the Recorded Video through Windows 

Explorer 

 

1. Find your unit through Windows Explorer (insert “\\” plus the IP 
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address of your unit) 

2. Insert the name and password of the administrator or power user. 

3. Open the “videodata” folder. 

4. Copy the date folder which you want to backup to your desktop / 

laptop. 

 

5.3 Backing up the Recorded Video through FTP 

 

1. Find your unit through Windows Explorer (insert “ftp://” plus the IP 

address of your unit) 

2. Insert the name and password of the administrator or power user. 

3. Open the “videodata” folder. 

4. Copy the date folder which you want to backup to you desktop / laptop. 

 

5.4 Playing back the Backup Records 

5.4.1 With Playback Application 

 

1. Use the Backup System application to back up your records. 

2. Check the Include Playback application option, which will add the 

Playback application into the backup folder. 

3. Open that folder. 

4. Double-click the Playback application icon. 

5. Select the recorded data to play back. 

 

5.4.2 Without Playback Application 

 

1. Use the Playback function to back up your records. 

2. Put your backup folder into the program folder of NVRmini. (Default 

directory is “C:\Program Files\NUUO\NVRmini”.) 

3. Go to Start > NUUO NVRmini > Playback System. 

4. Click the Open Record button. 

5. Select the recorded data to play back. 

 

5.5 Deleting the Recorded Video 

5.5.1 With Backup Application 

 

1. Go to Start > NUUO NVRmini > Backup System. 
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2. Insert the IP address of your unit. 

 

 

 

3. Insert the user name. 

4. Insert the password. 

5. Click the OK button. 

6. Click the New Period button. 

 

 

 

7. Select the record date. 
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8. Set the Start Time and End Time. (or highlight the video records which 

you want to delete) 

9. Select the cameras you want to delete the records. 

10. Click the OK button. 

11. Select the time slot which you want to delete. 

 

 

 

12. Click the Delete button. 

13. Confirm the check dialog. 
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5.5.2 Without Backup Application 

 

1. Find your unit through Windows Explorer (insert “\\” plus the IP 

address of your unit). 

2. Use the administrator’s ID and password to log in. 

3. Open the “videodata” folder. 

4. Select the date folder which you want to delete. 

5. Delete the folder. 

 

Caution 

In order to keep the system stable, do not delete recorded data 

from the day in which you do the delete process. 
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6. Logging out 

 

Click the Logout button on the top of the page to log out of the system. If 

there is no action in 10 minutes, the system will log out automatically to 

avoid unauthorized access. 

 

 

7. Remote PC System Requirements 

 

Remote PC Minimum Requirements 
Model 2 bay (4 channels) 4 bay (8 channels) 
OS Supported Windows 2000/ XP/ 2003/ Vista 
CPU Pentium 4 – 2.4 GHz Pentium 4 – 2.8 GHz 

RAM 512 MB 
User Interface 1. HTTP Web browser - Internet Explorer v6 or later 

2. Client Application Program 
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8. Troubleshooting 

8.1 Checking the System Status LED 

 

The system status LED reports the condition of the enclosure fan and 

power supply: 

 

� Green: normal 

� Amber: there is a problem with the fan or power supply 

� Red: the fan, power supply, or file system has failed 

 

If your unit is configured to work with a UPS, it will continue to run for a 

while after a power supply failure. 

 

8.2 Checking Disk Status LEDs 

 

The disk status LEDs report the condition of the disk drives: 

 

� Green: normal 

� Amber: rebuilding this disk drive 

� Red: failed disk drive 

� Dark: no disk drive is installed 

 

8.3 Replacing a Failed Disk Drive 

 

If a disk drive fails, the Disk Status LED becomes red. If the disk drive 

belongs to a RAID Volume, the Volume goes Critical or Offline. See 

“Checking RAID Volume Status” on page 89. 

 

Replace the failed disk drive with a new disk drive of the same or slightly 

greater capacity. You do not have to power down the unit. 

 

1. Open the unit’s front lid. 

2. Pull out the drive carrier with the failed drive. 

3. Remove the failed disk drive from the drive carrier. 

4. Install a new disk drive into the carrier. 

5. Place the carrier with the new disk drive back into the open slot in the 
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unit. 

 

If the failed drive belonged to a RAID Volume, the RAID Volume will begin 

rebuilding as soon as the new drive is installed. During the rebuild, the Disk 

Status LED shows amber. When the rebuild is finished, the Disk Status 

LED turns green. 

 

If the replacement drive is free, i.e., not assigned to a RAID Volume or as a 

spare, the Disk Status LED remains dark after you install the new drive. 

 

8.4 Checking RAID Volume Status 

 

1. Click RAID & File / RAID Management. 

2. Click the RAID Status tab. 

 

8.5 Responding to a Critical RAID Volume 

 

How the unit responds to a Critical RAID Volume depends on the RAID 

level of your Volume and whether you have a spare drive available: 

 

� For a RAID 1 Volume or a three-drive RAID 5 Volume, if a spare drive 

is available, the RAID Volume begins rebuilding itself automatically. 

� For RAID 1, 5, and 10 Volumes, when no spare drive is available, you 

must replace the failed disk drive. The RAID Volume will begin 

rebuilding itself when you install the new disk drive. See “Replacing a 

Failed Disk Drive” on page 88. 

� RAID 0 Volumes go offline after a disk drive failure. A RAID 0 Volume 

cannot be rebuilt. All data on the Volume is lost. 

 

8.6 Responding to an Invalid RAID Volume 

 

The system considers a RAID Volume invalid when the RAID Volume was 

created by a different unit. However, the RAID Volume itself remains 

functional and the data on it is safe. 

 

When the system does not recognize the RAID Volume, the unit displays 

the RAID Volume as invalid. 
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Use the Recover function to validate the RAID Volume. The Recover tab is 

only active when an invalid RAID Volume is present and can be recovered. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click RAID & File / RAID Management 

3. Click the Recover tab. 

4. On the Recover tab, click the option button beside the invalid RAID 

Volume. 

5. Click the OK button. 

6. The unit will reboot to update its configuration and recognize the RAID 

Volume. 

 

Important 

Running the Recover function might erase some or all of your 

settings. If that condition happens, run the Install Wizard to set 

them again. 

 

 

8.7 Checking File System Status 

 

Typically the first indication of a problem with the unit’s file system is when 

your drive becomes unavailable. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click RAID & File / File System Management. 

3. Click the File System Status tab.  

4. Look for the RAID Volume icon: . If the RAID Volume icon is Critical 

 (has a yellow “!”), the file system contains errors and you must 
rebuild the file system. 

 

8.8 Rebuilding the File System 

 

1. Open Internet Explorer and log in to the unit. 

2. Click RAID & File / File System Management. 

3. Click the File System Status tab. 

4. Click the RAID Volume Critical icon  to display the Rebuild File 
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System button. 

5. Click the Rebuild File System button. 

6. In the confirmation box, type “YES” into the field provided, and then 

click the OK button. 

 

8.9 Checking Enclosure Status 

 

1. Open Internet Explorer and log in to the unit. 

2. Click System / System Information. 

3. Click the Enclosure Information tab. 

4. If CPU temperature is above specification: 

 

� Be sure there is adequate air flow around the device. 

� Be sure the ambient temperature is below 35°C (95°F). 

 

5. Check the fan speed. 

 

� If the fan speed is below 1800 RPM, contact Technical Support. 

� If any power status is out-of-specification, contact Technical Support. 

 

8.10 Restoring the Default Administrator’s Password 

 

If you forget the password, and want to reset the Administrator’s password 

to the default password: admin, follow the following steps. 

 

1. Verify that the system is fully booted. 

2. Insert your reset tool into the reset button hole on the back of the 

device. 

3. Press and hold the reset button for 8 seconds, until the System Status 

LED flashes three times. 

4. The Administrator’s password is now reset to admin. 

 

Caution 

Pressing and holding the reset button for 8 seconds will restore 

the default Administrator password. Pressing and holding the 

reset button for 14 seconds will completely restore all of the 

default settings. 
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Caution 

Resetting or recovering your unit will sometimes cause data loss. 

Back up your recorded data before resetting or recovering your 

unit. 

 

 

8.11 Installing ActiveX 

 

If you cannot see the complete page of the system when using Internet 

Explorer, it may be because the ActiveX installation process is not 

completed. 

 

1. Open Internet Explorer and log in to the unit. 

2. Click the Live view / Playback button on the top right. 

3. The browser will ask whether to install ActiveX. 

 

 
 

4. Click the upper bar to begin the installation process. 

5. Click the Install button to complete the process. 
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8.12 Upgrade Process When Using Windows Vista 

 

Windows Vista limits user authority, which will cause it to block any 

connection through Windows Explorer. In this case, you need to change 

Vista’s settings to allow the connection. 

 

1. Go to Start >Control Panel. 

2. Select Administrative Tools. 

3. Select Local Security Policy / Security Options. 

4. Select “Network security: LAN Manager authentication level”. 

5. From the drop-down menu, choose “Send LM & HTLM – use NTLMv2 

session security if negotiated”. 

 

 

 

6. Find your unit through Windows Explorer (insert “\\” plus the IP 

address of your unit). 

7. Use the administrator’s ID and password to log in. 

8. Put the update file into the folder “public” in your unit. 

9. Open Internet Explorer and log in to the unit. 

10. Click System / System Upgrade. 
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11. Click the Firmware Upgrade tab. 

 

 

 

12. Choose the volume. 

13. Choose the folder “public”. 

14. Insert the entire file name, including the extension name. 

15. Click the OK button. 

16. The system will begin the upgrade process. 

17. After upgrade, the system will reboot. You need to re-access the unit 

again. 

 

8.13 Cannot Playback When Applying Windows 2000 

 

1. Check whether you have installed Media Player or not. 

2. If you have installed Media Player, check whether its version is version 

9 or later. 

 

8.14 Cannot Log in to the Unit with Internet Explorer 

 

1. Check the settings of your antivirus software. 

2. Change to appropriate settings or turn off this antivirus software. 
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Appendix – RAID System 

Introduction to RAID 

 

RAID (Redundant Array of Independent Disks) allows multiple disk drives 

to be combined together into a RAID Volume. You will create a RAID 

Volume on your unit when you perform the setup procedure. 

 

The benefits of a RAID can include: 

� Higher data transfer rates for increased server performance 

� Increased overall storage capacity for a single Volume 

� Data redundancy/fault tolerance for ensuring continuous system 

operation in the event of a disk drive failure 

 

Different RAID levels use different organizational models and have varying 

benefits. Also see “Choosing a RAID Level” on page 98. The following 

outline breaks down the properties for each RAID level supported on this 

unit: 

 

RAID 0 – Stripe 

 

When a RAID Volume is striped, the read and write blocks of data are 

interleaved between the sectors of multiple disk drives. Performance is 

increased, since the workload is balanced between drives or “members” 

that form the RAID Volume. Identical drives are recommended for 

performance as well as data storage efficiency. 

 

 

 

The RAID Volume’s data capacity equals the capacity of the smallest disk 
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drive times the number of disk drives. For example, one 100 GB and three 

120 GB drives will form a 400 GB (4 x 100 GB) RAID Volume instead of 

460 GB. 

 

If disk drives of different capacities are used, there will also be unused 

capacity on the larger drives. 

 

Because RAID 0 does not offer Fault Tolerance, meaning that you cannot 

recover your data after a disk drive failure, we do not recommend a RAID 0 

Volume for your unit. 

 

RAID 0 Volumes on this unit consist of one or more disk drives. 

 

RAID 1 – Mirror 

 

When a RAID Volume is mirrored, identical data is written to a pair of disk 

drives, while reads are performed in parallel. The reads are performed 

using elevator seek and load balancing techniques where the workload is 

distributed in the most efficient manner. Whichever drive is not busy and is 

positioned closer to the data will be accessed first. 

 

With RAID 1, if one disk drive fails or has errors, the other mirrored disk 

drive continues to function. This is called Fault Tolerance. Moreover, if a 

spare disk drive is present, the spare drive will be used as the replacement 

drive and data will begin to be mirrored to it from the remaining good drive. 

 

 

 

The RAID Volume’s data capacity equals the smaller disk drive. For 
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example, a 100 GB disk drive and a 120 GB disk drive have a combined 

capacity of 100 GB in a mirrored RAID Volume. 

 

If disk drives of different capacities are used, there will also be unused 

capacity on the larger drive. 

 

RAID 1 Volumes on this unit consist of two disk drives. 

 

If you want a mirrored RAID Volume with more than two disk drives, see 

“RAID 10 – Mirror / Stripe” on page 98. 

 

RAID 5 – Block Striping with Distributed Parity 

 

RAID 5 organizes block data and parity data across the disk drives. 

Generally, RAID level 5 tends to exhibit lower random write performance 

due to the heavy workload of parity recalculation for each I/O. RAID 5 

works well for file, database, application and web servers. 

 

 

 

The capacity of a RAID 5 Volume equals the smallest disk drive times the 

number of disk drives, minus one. Hence, a RAID 5 Volume with four 100 

GB disk drives will have a capacity of 300 GB. A RAID Volume with two 120 

GB disk drives and one 100 GB disk drive will have a capacity of 200 GB. 

 

RAID 5 is generally considered to be the most versatile RAID level. 

 

RAID 5 requires a minimum of three disk drives. 
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RAID 10 – Mirror / Stripe 

 

Mirror/Stripe combines both of the RAID 0 and RAID 1 types. RAID 10 can 

increase performance by reading and writing data in parallel while 

protecting data with duplication. At least four disk drives are needed for 

RAID 10 to be installed. With a four-disk-drive RAID Volume, one drive pair 

is mirrored together then striped over a second drive pair. 

 

 

 

The data capacity RAID 10 Volume equals the capacity of the smallest disk 

drive times the number of disk drives, divided by two. 

 

In some cases, RAID 10 offers double fault tolerance, depending on which 

disk drives fail. 

 

RAID 10 Volumes on this unit consist of four disk drives. 

 

Because all of the available disk drives are used for the RAID Volume, you 

cannot set up a spare drive with RAID 10. 

 

Choosing a RAID Level 

 

There are several issues to consider when choosing the RAID level. The 
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following summarizes some advantages, disadvantages and applications 

for each choice. 

 

� RAID 0 

 

Advantage Disadvantage 
� Implements a striped disk RAID 

Volume, the data is broken down into 
blocks and each block is written to a 
separate disk drive 

� I/O performance is greatly improved 

by spreading the I/O load across many 

channels and drives 

� No parity calculation overhead is 

involved 

� Not a true RAID because it is not fault 
tolerant 

� The failure of just one drive will result in 

all data in a RAID Volume being lost 

� Should not be used in mission critical 

environments 

 

� RAID 1 

 

Advantage Disadvantage 
� Simplest RAID storage subsystem 

design 

� Can increase read performance by 

processing data requests in parallel 

since the same data resides on two 

different drives 

� Very high disk overhead - uses only 
50% of total capacity 

 

� RAID 5 

 

Advantage Disadvantage 
� High Read data transaction rate 

� Medium Write data transaction rate 

� Good aggregate transfer rate 

� Most versatile RAID level 

� Disk failure has a medium impact on 
throughput 

 

� RAID 10 

 

Advantage Disadvantage 
� Implemented as a mirrored RAID 

� Volume whose segments are RAID 0 

RAID Volumes 

� High I/O rates are achieved thanks to 

multiple stripe segments 

� Very high disk overhead – uses only 
50% of total capacity 
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Spare Drives 

 

A spare is a disk drive that has been designated to replace a failed disk 

drive in a RAID Volume. In the event of the failure of a disk drive within a 

RAID 1 or three-drive RAID 5 Volume, the spare drive is activated as a 

member of the RAID Volume to replace a disk drive that has failed. 

 

A spare drive cannot replace the failed drive in a RAID 0 Volume because 

of the way in which data is written to the disk drives under RAID 0. 

 

A spare drive is not available for a RAID 10 Volume because RAID 10 

requires all four disk drives in the unit enclosure. However, when you 

replace the failed disk drive, the unit will automatically rebuild the RAID 

Volume using the new disk drive. 

 

You must designate a disk drive as a Spare. Use the system to designate 

the Free disk drive as a Spare. 

 

Maintaining a spare drive is a good precaution to protect your RAID Volume 

integrity in the event of disk drive failure. 

 

Automatic Rebuilding 

 

When a disk drive in your RAID 1, 5, or 10 Volume fails, and a replacement 

disk drive becomes available, the RAID Volume will rebuild itself to the new 

disk drive automatically. 

 

For RAID 1 and three-drive RAID 5 Volumes, you can designate a spare 

drive. If a spare drive is present when the RAID Volume experiences a disk 

drive failure, the rebuild will start automatically using the spare drive. 

 

For RAID 1, RAID 5, and RAID 10 Volumes without a spare drive, the RAID 

Volume will begin to rebuild itself automatically when you remove the failed 

disk drive and install a new disk drive. 

 

A RAID 0 Volume cannot be rebuilt because of the way in which data is 

written to the disk drives under RAID 0. Even if there is a designated spare 
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drive, rebuilding is not possible for RAID 0 Volumes. 

 

RAID Volume Migration 

 

Migration is the process of: 

1. Changing the RAID level 

2. Adding disk drives but keeping the same RAID level 

 

In the migration process, the existing RAID Volume is called the Source. 

The proposed RAID Volume is called the Target. Each target RAID Volume 

has certain requirements and they are different for each RAID level. You 

must meet all of the requirements in order to successfully migrate a RAID 

Volume. 

 

In most cases, you must add one or more disk drives during the migration 

process. You can never reduce the number of disk drives. 

 

While the migration is running, you can still access the folders on your 

RAID Volume and the data they contain. 

 

The following tables show the migration options for a source RAID Volume 

according to its RAID level. The available target RAID levels are shown 

with their requirements. 

 

� RAID 0 

 

A RAID 0 source Volume can migrate to the following target RAID levels: 

 

Target Requirement 
RAID 0 Add disk drives. 
RAID 1 2 disk drives minimum. 

A 1-drive RAID 0 can’t migrate to RAID 1. To do this, add 1 disk 

drive. 

RAID 5 3 disk drives minimum. 

At least 1 more disk drive than the RAID 0 RAID Volume. 
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� RAID 1 

 

A RAID 1 source Volume can migrate to the following target RAID levels: 

 

Target Requirement 
RAID 0 Can use same number of disk drives. 
RAID 5 3 disk drives minimum. 

At least 1 more disk drive than the RAID 1 RAID Volume. 

 

� RAID 5 

 

A RAID 5 source Volume can migrate to the following target RAID levels: 

 

Target Requirement 
RAID 0 Can use the same number of disk drives. 
RAID 5 Add a disk drive. 

 

� RAID 10 

 

A RAID 10 source Volume cannot migrate or add more disk drives. 


